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Book Three
OU Campus

EndUser Reference 
Guide
This technical reference guide is the third 

book in a series of three that will guide you 

through the redesign and redevelopment 

of your website. The planning guide 

helps you think through your content, 

structure, audience and goals. The style 
guide introduces the page designs and 

content modules you’ll use to bring your 

planning to life as a website. The end-user 
reference guide shows you how to use the 

content management system to build the 

site you planned.
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Begin the OU campus journey. Learn how to access OU campus, navigate 

the directory structure for a site, edit pages, use gadgets to add images, 

snippets, and streamline work. 
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OU Campus Tour 
Logging In and Out 

1.   Click the copyright symbol (1) in the bottom left 

corner of the black bar to login directly to a web page 

and begin editing it in OU Campus.

1

2.   The first access will present a screen from 

inCommon – select “University of South Carolina” from 

the dropdown menu (2), the “Remember my selection 

permanently” radio button (3), and then click “Next” 
(4).

3.    The USC login screen will appear. To authenticate, use 

the USC network username and password (5) managed 

via my.sc.edu (https://my.sc.edu).  

To log out, exit the browser used to access OU Campus by 

closing all open tabs. The “Logout” button in OU Campus 

does not provide this function.

1

2

3

4

5
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Below are close-ups of the above 3 columns

Dashboard Tab
The Dashboard tab (1) is the default view in OU 

Campus.  It allows managing common tasks performed in 

OU Campus – communicating with other users, reviewing 

pages (if the user is an approver), and monitoring pages 

checked out to the user.  

The Dashboard tab consists of four gadgets that can be 

toggled on/off via the “Configure Dashboard” link (2):
     (3) Inbox – shows a list of messages sent to the   

           user, if any. 

     (4) My Checked-Out Content – shows a list of   

           checked out content by the user, including pages 

           and assets being edited or awaiting approval.  Click        

           on the linked page/asset to begin editing or 
           approval (5) or on the      ,       , or          icon (6) to 

           check it in for other users to edit. 

     (7)  Workflow – shows all items in a user’s workflow,  

           sent to another user for approval or awaiting this   

           user’s approval. 

     (8)  Activity – lists the most recent actions performed 

           in the site. 

Regularly refer to the “My Checked-

Out Content” gadget and click the 

yellow light bulb icon to release pages 

no longer being edited so that they 

are available to the other site users.

3 4
5

6

78

1

Column 1 Column 2

Column 3

     
 

Remember

2
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Content Pages View
The Content->Pages view is the default view of the Con-
tent tab (1).  It allows navigating the site directory struc-

ture, checking out and editing existing pages, creating 

new sections and pages, as well as accessing the page 
action toolbar (2).   

Page Action Toolbar
The page action toolbar will appear when hovering 

over a page.  It consists of four menus: “Edit”, “Review”, 

“Publish”, and “File”.  Each menu displays a set of page 

actions.  The available actions depend on the user 

permission level as well as the status of the page.     

Pages that are not checked out will 

NOT display all available options.

2

1

     
very 

important!
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The Edit Menu
The Edit menu allows editing the content and structure of 

a page, modifying access to it, and scheduling reminders 

or notifications for the page. 

• Page – access the editable regions on the page

• Properties – access the page properties to edit the 

page title, breadcrumb for the page, banner image 

and slideshow, and turn on/off certain editable 

regions.

• Access – Submit a Service Desk ticket to have 

access    settings modified.  If certain users should 

not have    access to the entire site, provide their 

names and    what sections or pages they should be 

restricted to. 

• Reminders – receive notifications for the page on   

certain date and time. 

The Review Menu
The Review menu allows previewing the page before 

publishing, adding it to the version archives, or viewing the 

history of page modifications.   

•    Preview – preview the page on the staging or local   

     USC servers and on multiple platforms  

•    Page Check - check the page for broken links  

•    Save Version – save a version of the page as it exists 

     now in OU Campus  

•    Versions – view page versions or revert to a 

     previous page version  

•    Log – view all of the saves and publishes for a page

The Review Menu

The Edit Menu

8University of South Carolina Web Redesign and Redevelopment
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The Publish Menu
The Publish menu allows making a page visible on the web 

site.  Users who have an approver will have to send the 

page to their approver for publishing. 

• Publish – send a page to a local USC server making 

it available for viewing immediately

• Schedule – send a page to a local USC server at a 

future day, and receive notification once the page is 

published

• Submit for Approval – send the page to another 

user who will review the changes and either publish 

the page or request further changes be made

• Expire – schedule a page to expire on a specific 

date and time.  The page contents can be replaced 

with text from another page, the page can be 

redirected to another page, or the page can be 

deleted. 

The File Menu
The File menu is only available to site managers and gives 

the options to rename, move, copy, or recycle pages.

• Rename – change the file name for the page but  

leave the “pcf” extension.   

• Move – move a page to a different directory.

• Copy – create a copy of the page in the directory   

of choice.  Note that this is different from backing 

up a page version via the “Review” dropdown menu 

above.

• Move to Recycle Bin – remove a page from the local 

USC server.  An archive of the page will be retained 

on the staging server and the page can be restored 

later if needed.

  

     
very 

important!

The File Menu

The Publish Menu

Unlike pages, folders and sections in OU Campus cannot 

be recycled.  Deleting a folder or section via the “File” 

menu will permanently delete it from all servers.  To 

delete a section or folder, first recycle all pages in it and 

then delete it.  When a page from the deleted section 

or folder is restored, the containing directory will be 

restored as well.

9University of South Carolina Web Redesign and Redevelopment
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Most of the page action options are also available from 

the top grey tabs of the “Edit” or “Review” views:

• Click either the                  or                        menu when 

hovering over a page.  

• To preview a page:

        a.  After the page loads up, select the “Preview” tab 
            (1) and choose the server the page will be 

            previewed on (2) OR 

        b. Click the button to preview the page on multiple 
            browsers and operating systems (3).  

• To access page properties:

        a.  Click the light bulb icon (4) to check out the page. 

        b.  Click the “Properties” button (5) or make changes 

             directly via the “Page Parameters” gadget (6). 

1 45

Below are close-ups of the above

2 3

6
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Page Editable Regions
A page is divided into one or more editable regions.  The 

editable regions on a page are marked with green “Edit” 

buttons or an orange “Multi Edit” button.  Typical editable 

regions are intro paragraph, main content area, callout 

column, and banners.  

To access a page editable region:

1. Navigate to the page on the web site outside OU 

Campus and click on the copyright symbol in the 

left bottom corner of the screen  

 

OR 

2. Hover over the page in the Content Pages view inside 

OU Campus and select the Edit menu (1) or its “Page” 
option (2). 

3. Click on a green “Edit” button (3) to begin editing 

a page region with the JustEdit toolbar editor or an 

orange “Multi Edit” button to access a form-like wizard 

that may include mini WYSIWYG editors.  

 

 

       

1
2

3
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Gadgets
Gadgets provide additional functionality or streamlined 

access to functionality.  They appear on the Dashboard 

(see the Inbox, My Checked-Out Content, Workflow, 

and Activity gadgets discussed earlier) and in a special 

Gadgets sidebar.  The Gadgets sidebar will appear when 

the  icon in the upper right corner is clicked. The most 

important gadgets are:

• My Checked-Out Content (see the Dashboard section)

• Images

• Dependency Tag

• Page Info

• Snippets

• Page Parameters

The Page Info and Page Parameters gadgets will appear 

ONLY after a page is selected for editing. The Images and 

Snippets gadgets will appear ONLY after a page editable 

region is accessed.  

Quick
Tip!

If any of these gadgets does not appear even 

after a page editable region is selected, click the   

 icon inside the Gadgets sidebar and make 

sure the check box for the respective gadget is 

selected. 

12University of South Carolina Web Redesign and Redevelopment
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Images Gadget
The images gadget will appear only after a page editable 

region is accessed.  It is used to access images already up-

loaded to OU Campus and provides the same functionality 

as the        JustEdit tool explained in the JustEdit toolbar 

section.  The advantage of the images gadget is that it 

allows dragging and dropping of images. 

• Use the                                  (1a) or            icons (1b) in 

the images gadget to navigate to the folder where the 

image resides.  Click “Select” (2). 

• A preview of all images in the selected folder will ap-

pear inside the Images Gadget (3). A preview of the 

image will NOT appear in the Select Folder window 
(4). 

• To insert an image, drag the image from the gadget 

into the editable region until the cursor moves to the 

location where the image needs to be inserted.  Alter-

natively, place the cursor where the image needs to 

be inserted, click on the image in the gadget, and then 

click the “Insert” button (5). 

 

         

 

1b

1a

2

5

4

3
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Dependency Tag Info Gadget
Each page, asset, or file in OU Campus has an associated 

dependency manager tag.  This gadget allows looking up 

the type, file name, and path to the resource, as well as the 

pages that are using it.   

Page Info Gadget
The page info gadget will appear only after clicking on 

a page or accessing its editable region.  It shows when 

a page was last saved or published, its parent directory, 

and a list of all dependency tags used by the page (either 

assets dropped on the page or links to other pages).  This 

gadget is very helpful, especially when used together 

with the dependency tag info gadget.  Clicking on the link 

under “Page Products” (1) allows viewing the page on the 

live site (not on the OU Campus staging server).  Click-

ing on the dependency tag for the page (2) opens the 

dependency tag info gadget and shows a list of all pages 
linking to the current page (3). Clicking on an asset in the 

“Assets” list (4) takes the user to that asset.  Clicking on 

the dependency tag for that asset (5) opens the depen-

dency tag info gadget and shows the “subscribers” or 

pages using this asset (6). 

         

 

6

1

54

2

3

14University of South Carolina Web Redesign and Redevelopment



Book 1 Planning Guide     Book 2 Style Guide     Book 3 EndUser Reference Guide

Snippets Gadget
The snippets gadget will appear only after a page edit-

able region is accessed.  It provides the same functionality 

as the JustEdit tool explained in the JustEdit toolbar 

section.  The advantage of the snippets gadget is that 

it allows dragging and dropping of snippets.  To insert a 

snippet, place the cursor in the editable region where the 
snippet will be placed (1) and drag it from the gadgets 
sidebar (2).  Alternatively, click on the snippet and then on 

the “Insert” button (3).    

Page Parameters Gadget
The page parameters gadget allows editing the page 

properties directly from the Gadget sidebar after a page is 

checked out.  

         

 

1

3

2

|
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Sections and pages are the main building blocks of the site structure. A 

section is not only a folder in the site directory, but it also permanently 

displays in the breadcrumb, has its own index page and configurable 

properties, and can have its nested structure displayed in the left 

navigation. Pages can also be represented in the left navigation as part of a 

section but will only appear in the breadcrumb when being viewed. 

Section Two
Sections and Pages Section Contents

Sections  .................................................................................................. 18
Pages  ......................................................................................................20
      Generic Page  ...............................................................................20
      Page Quick Starts  .......................................................................21
      Profile Page ....................................................................................21 
      News Archive Section  ..............................................................22
      News Article Page  .....................................................................23 
Page Properties  ................................................................................. 24
Section Properties  ............................................................................25 
       Breadcrumbs  .............................................................................. 26
       Navigation  ....................................................................................27
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Sections and Pages

Sections and pages are created via the “Pages” option of 

the “Content” tab.  Click on the                    button (1) and 

select one of the available section or page templates (2).

When a new section is created, OU Campus will generate 

a folder for the section, an index page, a section proper-

ties file, and a navigation file.  These files cannot be creat-

ed by themselves.    

The only way to create the left navigation hierarchy is to 

create sections within sections.  Pages should be created 

inside sections to create sibling links (links at the same 

level) or at the last level within a section where no further 

hierarchical grouping of content is needed.  

 

 

Create all pages as sections if possible.  

In this way even if you don't have a need 

to build child links in the left navigation 

under the page, you can do that in the 

future without having to recreate the 

page as a section.  Only profile pages 

and news pages cannot be created as 

sections.  All sections and pages must be 

part of the navigation except profile and 

news pages.

     
very 

important!

1

2
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Sections
Sections are special folders that contain three different 

types of files: 

• “index.pcf” – the main page for the section that dis-

plays its left navigation.

• “_leftnav.inc” – the file that contains the left naviga-

tion links.  Links to index pages for subsections visible 

at this level and to non-index pages in the current 

section are maintained here.  

• “_section.prop.pcf” – the section properties file that 

manages configurable parameters for all pages in a 

section.    

To create a new section, select the “New Section” tem-

plate and fill out the information below:

General
• “Folder Name” - used to create the site directory 

structure on the staging and USC servers.  NOT visible 

on the web site except in the URL.

• “Section Title” - Used to create the following four 

elements visible on the web site:

 ◦ Main page title (T) for the index page of  the new 

section.

 ◦ Section heading on non-index pages.  Displays as 

gray, uppercase text above the page title.  Updat-

ed via page properties of the “_section.props.pcf” 

file.

 

     

caution
"Folder Name" should be lowercase, with 

NO space or special characters.
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 ◦ Path to this section in the breadcrumb (BT).  Up-

dated via page properties of the “_section.props.

pcf” file.

 ◦ A link in the left navigation(UN) if “Navigation 

Item” is set to “Yes.”   

• “Navigation Item” - choose “Yes” to add a link to the 

index page for this section in the left navigation.

• “Index Page Keywords” and “Index Page Description” 

- create the meta tags and description.

Index Page Layout
• “Index Page Type” - choose a type for the index page. 

The different page types are explained below.  

• “Intro” - enable an introductory paragraph for the 

page (IP).
• “Callout Column” - selected in conjunction with the 

“Use Local callouts” checkbox to enable the callout 

editable region (C). 

Index Page Banner
• “Banner Source” - choose “Hide” to not show it, “Cus-

tom” to select it via the “Single Image” field, or “Inher-

it” to use the banner image specified in the “_section.

prop.pcf” file in this section.  

• “Banner Type” - choose between a slideshow or a 

single image.

• “Single image” - navigate to an already uploaded 

banner image (B) by clicking the image button (1).  
Leave blank for image slideshows. 

• “Single Image Alt Text” - provide a description for the 

single image.  Leave blank for image slide-shows. 

Click “Create” to save changes and exit the section wizard. 

Required Optional

1

T

IP

SL

C

BT

UN B
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Pages
The three templates types are generic, profile, and news 

article.  All but the profile and news article types are 

available from the “New Page” template. Select the type 

of page from the “Page Type” dropdown. The rest of the 

fields are identical to the fields on the new section wizard.  

Generic Page
A generic page is a blank-slate page that can be used for 

basic text content or configured with the various modular 

elements (known as snippets) to create most of the page 

types discussed in the Style Guide.  

Page Quick Starts
In addition to the specific page templates, OU Campus has 

built-in quick starts to speed up the process of configuring 

the page types.  Please refer to the Style Guide available 

from the “Add-Ons” tab in OU Campus on their proper 

use.  

• Multilink List Page - onfigures the page with a multi-

link list snippet.  It does NOT allow the use of callouts. 

• Simple List Page - configures the page with a simple 

list snippet.  

• Table Page - configures the page with a table.  It does 

NOT allow the use of callouts. 

• Data Table Page - configures the page with a data 
table (1). Additional data tables can be inserted as 

content snippets (2a or 2b). Additional information is 

available in the Snippets section.

• Grid Page - configures the page with a grid snippet. 

No other page elements, except an intro paragraph, 

are allowed on a grid page.

For the “Filename” field of the “New 
Page” wizard,  replace “untitled” with a 
file name for the new page but do NOT 
change the “pcf” file extension.

2b

2a

1

Data Table Page

     

caution
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Profile Page
This page type is visible only inside the “faculty-staff” 

section and is used to create a person’s profile page.  In 

addition to the familiar fields of the new page wizard, the 

profile wizard has a section for providing contact infor-

mation to be displayed in the faculty directory and on the 

profile page.  Once a profile page is created, it will display 

two editable regions.  The “MultiEdit” button allows edit-

ing the structured information (SI) and adding a profile 
photo (PP).  The “Edit” button allows typing the free-form 
information (UI) – the headlines for all sections (e.g. Back-

ground, Teaching) should be styled as 

Heading 4.    

Profile Page

SI

PP

UI
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News Landing Page

News Archive Section
At the beginning of each calendar year on January 1:

1. Use the 'New News Archive Section' template to 

create a new archive section  and begin creating news 

articles for the current calendar year in it.  

a. Type the current calendar year for the "Folder 

Name", e.g. 2016.  

b. Type "{current calendar year} News Archive" for the 

"Section Title". 

c. Leave "Yes" for "Navigation Item".  

 

2. Schedule a publish for the index page of the archive 

section to keep it updated when news articles are 

added or updated.  

3. Cancel the scheduled publish for the previous calen-

dar year. 

4. Update the main news landing page with a link to the 

archive section. 

1

4

1a

1b

1c
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3

2

124 x 124 px

1

News Landing Page

5

6

News Article Page
This template is visible only inside the “news” section and 

is used to create a news article.  It is basically a generic 

template with an RSS item associated with the story.  

The template has the same fields as the new page wizard 

(“Article Heading” serves as the “Page Title”).  The addi-

tional fields, used to create an RSS item when the page is 

published, will display in the dynamic news article lists on 

the home and news landing pages.  The Article Title (1, 
AH) will become the page title of the news article and the 

list item headline.  The Article Teaser (2, AT) will display 

under the list item headline.  The Image (I) is rendered by 

thumbnail image (3) associated with the news item. 

 

If the dynamically created news list item needs to be edit-

ed, this can be done via the RSS menu item.

1. Check out the news article page and select “RSS” (4)
from the “Edit” menu while hovering over the page. 

 

2. Click on the link for the RSS item (5).  

3. Make updates and click “Save.” 

4. Click the “Rebuild Feed” button and publish the RSS 
feed (6).  

News Landing Page

4

AT

AHI
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News Landing Page

Page Properties
Page properties are accessed to modify the settings con-

figured with the new section and page wizards.  A page 

has to be checked out to access its page properties in one 

of two ways:

• Hover over the page and choose the “Properties” (1)  
option of the “Edit” menu OR 

 

• Click on the page and expand the Page Parameters 
gadget (2).

  

 

 

         

1

2
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Section Properties
Each section has a "_section.prop.pcf" file whose page 

properties affect certain elements for all pages in the cur-

rent and lower-level sections.  Every time this file is mod-

ified and republished, all pages and sections at the same 

or lower level in the directory tree must be republished for 

the changes to take effect.

Fields that only exist in page properties of the “_section.

prop.pcf” in each section are:

• “Section Heading”(1, SH) - appears on non-index 

pages ONLY and is set for each section.  Sections 

within a parent section can use the parent section 

heading.  This configuration requires setting the 

“Section Heading” for each section's “_section.props.

pcf” file to “Inherit from parent folder.”  Since it can be 

hard to keep consistent in a large parent section with 

multiple levels of sections, be sure to preview all your 

pages and sections to make sure they are showing up. 

• “Sub-Unit Header”(2)- used to designate structurally 

distinct units within larger organizations that share the 

same website, e.g. the “Parenting & Family Research Cen-

ter” within the College of Arts and Sciences.  Just like with 

the section heading, it has to be enabled in every section 

and can be set to inherit in the same way. 

• “Hide Local Navigation”(3) - selecting this checkbox 

will hide the siblings for a page from appearing in the 

navigation.  This selection should be made for the “_

section.prop.pcf” file inside the “news”, “faculty-staff” 

sections, and any section whose only page will be the 

index page.  Even if there are no links in the “_leftnav.

inc” file, check this box so that there isn't a thick light 

gray line below the garnet box in the left navigation 

for the section.

  

1

2

3

SH
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Topmost “_section.prop.pcf” File
The “_section.prop.pcf” file located at the top level of the 

site has unique fields in page properties that are used to 

update the Unit Footer (UF).  Any time this file is updated, 

the entire site has to be republished by the OU Campus 

Administrator. 

The last two fields (1) are used to update the black bar 

on the footer – bottom right corner with the site owner 
information (SO).  The “Site Owner HREF” link should be 

either a path to a web page or an email address (e.g. mail-

to:youremail@mailbox.sc.edu).

Breadcrumb
The breadcrumb is updated via page properties.  The 

breadcrumb for a section is updated via the “Title” field 

of the “_section.prop.pcf” file inside the section.  The 

breadcrumb for a page will appear only when the page is 

viewed and is updated via the “Title” field of the page. 

 

Unit Footer

UF

SO

1

UF

SO

BT

The site name is updated via the MultiEdit 

button. The rest of the fields are updated 

via page properties.

Quick
Tip!
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Navigation
The navigation for a site (UN) should follow the directory 

structure in a top-down manner – the links in the “_leftnav.

inc” file of the parent section should link to the “index.

pcf” pages of subsections and to regular/non-index pages 

in the same section.  No subsections should be skipped 

along the way.  

The “_leftnav.inc” file controls the children of the current 

section.  If “Yes” is selected for "Navigation Item" when 

sections and pages are created, the links will be generated 

in the “_leftnav.inc” file in the order in which the sections 

or pages were created.  Making manual changes to the 

“_leftnav.inc” file should be kept to a minimum but is 

needed when sections or pages are moved around.

To reorder links in the navigation, go to the parent folder 

for subsections and stay in the same folder for non-index 

pages.  Edit the “_leftnav.inc” file with the JustEdit tool-

bar moving the bullets with the links in the desired order.  

Publish the updated “_leftnav.inc” file for the changes to 

take effect.  

 

  

  Updating the links on the homepage for a 

site is approved by Digital Strategy  

(formerly Web Communications). 

     
very 

important!

UN
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Learn how to upload images in OU Campus as well as update banner 

images and slideshows. 

Section Three
Images and Files Section Contents

Uploading Images and Documents   ....................................... 29
Folders  .................................................................................................... 31
Content Page Banners  ....................................................................32
      Single Banner Image  ................................................................32
      Banner Image Slideshow  .......................................................33
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Images and Files 
Uploading Images and 
Documents 
 

Images or documents (PDF, Word, etc.) are uploaded via 

the Content->Pages view.  The easiest way to upload im-

ages and documents is by dragging and dropping them.

1. Navigate to the location where the image/document 
should reside (1) – either the “images” folder or one of 

its subfolders. 

2. Click the “Upload” button (2).  
Images can be uploaded by dragging and dropping 

(described below) or by clicking the “Add Files” (3) 
button in the upload window and selecting one or 

more files to be uploaded at the same time.  Steps 5-7 

below are the same for both methods. 

3. Navigate to a folder on the local computer and select 

one or more files.

4. Drag the files into the browser icon in the task bar and 

then into the Upload window.

5. Click the “Rename” button (4) for each image/docu-

ment if its file name is NOT lowercase or has spaces or 

special characters.

6. If another image or document with the same name 

already exists at that location and it needs to be over-

written, select the “Overwrite Existing” checkbox (5)
7. Click “Start Upload” (6).
8. Publish the uploaded image to both test and produc-

tion server.

 

1
2

3

5

6

     
very 

important!

Before uploading images in OU Campus, make sure 
the image being inserted has the correct dimensions 
for its type as specified on page 87 of the Style 
Guide (click the “Add-Ons” tab in OU Campus to 
access the Style Guide).

4
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Inserting uploaded images
Images uploaded to OU Campus can be inserted either 

via the JustEdit  icon (1) (as described in the JustEd-

it Toolbar section) or directly via the Images gadget (as 

described in the Gadgets section). Images should have the 

correct dimensions before being uploaded to OU Campus  

as specified on the Style Guide. 

 

 

         

1
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Folders
Folders are created via the Pages option of the Content 

tab when their only purpose is to store images and docu-

ments.  

1. Click on the “Content” tab and select the “Pages” 

view.  

2. Click on the plus sign in the “New” button                     . 

3. Select                            .  

4. Provide a name for the new folder that will display in 

the directory structure.  The name should be lower-

case, with no spaces or special characters. 
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Content Page Banners
Banners on all pages, except the home page, can be either 

a still image or a slideshow of up to 5 images.   

Single Banner Image
Still image banners can be added when creating a page 

or set up under page properties.  If the page has already 

been created without a banner and the banner image is 

already uploaded in OU Campus, access page properties 

to navigate to the uploaded image.

In the Banner section, designate the source of the banner: 

the same banner specified in the “_section.prop.pcf” file 

for the section where the page resides (“Inherit”), a cus-

tom banner (“Custom”), or none (“Hide”). 

To use a custom single image banner, edit the page prop-

erties form: 

1. Choose “Custom” for “Source.”  

2. Make sure “Single Image” is selected for “Type.” 

3. Click the         button of the “Single Image” field and 

navigate to a previously uploaded banner image (825 

by 350 px).  

4. Provide a description of the image in the “Single Im-

age Alt Text” field.  

5. Click “Save” to save the changes to page properties. 

 

     

1

2
3

4
5

When using photography, choose striking and simple imag-

es to convey your message. Tighter cropping and a focused 

subject matter will create better images.

best
practice
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     1

2

3

Banner Image Slideshow
Slideshow banners and single image banners with cap-

tions are also enabled in page properties but edited via 

the                           button above the banner in edit view. 

On the page properties form: 

1. Choose “Custom” for “Source.”  

2. Select “Slideshow (up to 5 images)” for “Type.” 

3. Click “Save” to save the changes to page properties. 

4. Select the “Edit” tab to view the editable regions. 

5. The  button will appear above the place-

holder image.  Click on it to begin editing the slide 

show in the JustEdit toolbar – there is an individual 

table for each slide in the slide show. 

                  

4

5
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To change the image, delete the placeholder image (1) 

and click the  JustEdit button or access the Images 

Gadget . 

• “Show this image?” – change the “1” to a “0” to NOT 

show this image in the slideshow. 

• "Video banner?" - type "1" to make this image a video 

banner. 

• “Sequence number” - this sets the order of the image 

in the slideshow. 

• “Caption head” (optional) - this text will be styled in 

bold Sweet Grass green color.  Leave blank if no cap-

tion head is desired. 

• “Caption body” (optional) - this text will be styled 

below the caption head in regular weight white text.  

Leave blank if no caption is desired. 

• “Link” – place the cursor inside this placeholder link 

and use the tool to navigate to a page inside this sec-

tion.  If no linking is desired, either unlink the place-

holder link or delete the text. 

• “Alt text” - this is the text a screen reader will read (2).    

Make it descriptive for accessibility. Do NOT leave 

blank.

 

          

1

2
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Home Page Banner  
Slideshow
The home page can accommodate a single image, a slide-
show of images or a video in the banner slot.  These options 
are accessed via the button above the banner.  
When the form wizard loads, five different slide sections 
will appear, each representing one slot in the slideshow.  For 
each slot, the following options are available: 
• “Banner type” - choose the type of banner image
• “Show this slide” - this check box turns this slide on or 

off without having to remove its content
• “Enable Video” - select this checkbox to turn on the 

video functionality
• “Order” - this dropdown sets the order of the slides, 1 - 5
• “Image” (1)  - allows navigating to a previously up-

loaded image to use as the banner (1140 by 580 px)
• “Image Description” - this is the ALT text for the image 

read by screen readers and required for accessibility
• “Caption head” (optional) - this is the larger Sweet 

Grass green text in the caption box.  To show empha-
sis, select the main word(s) in the headline and click 
the   button to make the text bold.  See more informa-
tion about showing emphasis with text weights in the 
Style Guide available via the Add-Ons tab.

• “Caption body” (optional) - this is the smaller white 
text in the caption box.

• “Caption position” (optional) - as indicated in the 
Style Guide, the caption box can be placed in the top 
right, bottom right, or bottom left corners. Choose the 
placement based on what looks best with the image. 

• “Link” (2) – used to link the banner to a page.  The text 
will appear as a link below the caption in the same box.  
It is optional except for a video banner image, in which 
case the actual text of the link will not be shown. 

     

1

2
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Learn how to use the JustEdit toolbar to format text, add pull quotes, and 

insert images, tables, snippets, and assets. 

Section Four
JustEdit Section Contents

Toolbar  ....................................................................................................37
      Copying/Pasting Content  ......................................................38
      Headings and Paragraphs  .....................................................38
      Adding a Pull Quote  .................................................................38
      Adding or Editing Hyperlinks  ............................................. 39
      Images  ............................................................................................ 39
      Tables  ..............................................................................................40
      Snippets  .......................................................................................... 41
      Assets  ............................................................................................... 41
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   Save and Exit 

   Exit without saving 

   Cut 

   Copy 

   Paste 
 

   Paste as Plain Text 
 

   Find or Find and Replace 
 

   Undo

   Redo

   Spell check 

   Remove Formatting: removes  
         all formatting for selected text  
         and restores the default settings
 

   Bold

   Italic

JustEdit Toolbar 
JustEdit is a new way to edit content in OU Campus that allows users to edit pages without leaving the "Preview" view of the content. In the Just Edit 

editor you can add, edit, and style your text as you would in a word processor; clicking on an editable region will bring up the JustEdit toolbar and the 

region will become available for editing. 

    Insert/remove bulleted list
  

    Insert/remove numbered list 
 

    Decrease indent 
 

    Increase indent

    Pull Quote: adds the styling for a pull  
          quote with large quotation marks and  
          gray box
 

    Superscript

    Subscript
 

    Insert/edit links

    Remove links

    Insert/edit mailto links

    Insert/edit anchor 

    
 

   Preset Paragraph options 
 

   Preset Styles options

     Insert/edit Images 
 

     Insert horizontal line 
 

     Insert line break 
 

    Insert special character

      Show blocks
          Clicking this icon surrounds  
          block-level elements on the page  
          with a dotted line and labels them  
          with a small tag.

    Insert a snippet  
          (see the Snippets section for  
          more information)
 

    Insert an asset that has been  
           created in the asset manager  
           (see the Assets section for more  
           information)
 

    Create/edit tables 

    Maximize Content Region: this  
           is especially helpful when working  
           in a callout column      
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Copying/Pasting Content
The and  JustEdit icons are turned off by default 

in Firefox.  To copy and paste content, use the keyboard 

shortcut commands “Ctrl+C” and “Ctrl+V” respectively.  

Headings and Paragraphs
Allowed headings on a page are Heading 3 through Head-

ing 6.  Heading 2 is reserved for the main page title which 

is created by the new page wizard.  Headings and para-

graphs are added by placing the cursor inside the text and 

making a selection from the  menu. 

         

Adding a Pull Quote
To create a pull quote, place your cursor inside the text 

and click the   icon.  When regular text is added after 

the pull quote, the quote icon has to be clicked again to 

exit the quote mode.  See the Style Guide available from 

the Add-Ons tab in OU Campus for more information on 

when and how to use pull quotes.

When copying content outside OU Campus, 

it is important that the JustEdit  icon be 

clicked before pasting the content to remove 

extraneous code that can affect adherence to 

the official web styles and templates or even 

break the page.  Alternatively, content can be 

pasted into a text editor like Notepad first, cop-

ied from there and then pasted into the with 

the JustEdit toolbar.

     
very 

important!

Using the path bar at the bottom of the 

page to check to see if any additional 

styling is applied. It should end in p or an 

H3/H4/etc. but not in span.

Quick
Tip!
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Adding or Editing Hyperlinks
Hyperlinks to pages are created by highlighting text and 

clicking the  icon.  They are removed with the        

icon.  

When inserting a link, the          button (1) should always 

be used to navigate to pages maintained within OU Cam-

pus in order to prevent broken links.  Only links to pages 

outside of OU Campus should be typed or pasted in the 

“URL” text box (2) to the left of the  button.  

Links to pages not within the sc.edu domain and to docu-

ments (PDF, Word, etc.) should open in a new tab.  These 

links should have “New Window” selected for “Target” 
(3) and will automatically render with the  icon unless 

located in simple and multilink lists. 

To insert email hyperlinks, use the  icon.  

Images
Images previously uploaded to OU Campus can be in-

serted via the JustEdit  icon.  Use the button (1) 
to navigate to a previously uploaded image and provide a 

description of the image for accessibility (2).  

Do not modify the dimensions for the im-

age.  All images should be resized before 

being uploaded to OU Campus.  More infor-

mation about the correct image dimensions 

based on the image type can be found on 

the Style Guide available from the Add-Ons 

tab in OU Campus. 

     
very 

important!

2

1

Be sure to review the link styles section of the Style Guide 

before adding any links to you pages. Use contextual links 

and avoid any “click here” type language. Set proper con-

text around the link so that a site visitor has a general idea 

of what they are going to see before clicking.

2 1

3

best
practice
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Tables
Tables are inserted with the JustEdit icon, use this 

option when building either really simple tables (just two 

columns) or complex tables with merged cells. Otherwise 

use the 'Responsive Table' snippet. Use the 'Responsive 

Table' snippet to create mobile-friendly tables. Do NOT 

provide width or height or drag the table borders. 

To add rows to a table, place the cursor inside the table, 

select the  icon (1), hover over the 'Row' (2) option 

and choose "insert Row Before' or 'Insert Row After' (3).  

 

     
very 

important!

DO NOT FILL OUT THIS SECTION

If you provide width or height in table 

properties or drag the table column 

borders, the table will no longer be 

mobile-friendly.  

A table can be deleted by placing the 

cursor inside it and choosing 'Delete 

Table' from the  dropdown. This 

table menu can also be accessed by right 

clicking inside of the table.

1

2

3

Quick
Tip!
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1 choose category

2 choose snippet

Snippets 
The JustEdit  icon is for inserting snippets on pag-

es.  More information about snippets can be found in the 

Snippets section.

Assets
Assets are first created with the asset manager via the 

Content->Assets view.  Once created, they are inserted on 

pages.  To insert an asset, select the  JustEdit icon.  
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Snippets are used to insert preformatted web content inside a page 

editable region. They are grouped under categories. The two categories 

of snippets currently used are content and callout. Content snippets 

are inserted in the main editable region of  a page. Callout snippets are 

inserted in the callout editable region. 

Section Five
Snippets Section Contents

Inserting a snippet  ........................................................................... 43
Content snippets  ..............................................................................44
      Simple List  .................................................................................... 45
      Multi-link List  ..............................................................................46
      Image Grid Item  ..........................................................................47
      Expand-Collapse Widget   .................................................... 48
      Responsive Table  ...................................................................... 49
      Data Table  ..................................................................................... 49
Callout snippets  ................................................................................50
      Simple Callout  ............................................................................. 51
      Spotlight Callout  ........................................................................52
      Quick Fact Callout  .....................................................................53
      Audio Callout  .............................................................................. 54
      Video callout  ................................................................................55
      Image Gallery Callout  ............................................................. 56
      Single image Gallery Callout  ...............................................57
      Form callout  .................................................................................58
      Twitter Callout  ............................................................................ 59
      Calendar Callout  .......................................................................60 
      Contact Callout  ........................................................................... 61
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Snippets
Inserting a snippet
 

As discussed earlier, snippets can be inserted in one 

of two ways: via the JustEdit icon (1) or via the 

 gadget (2).

Most snippets have placeholder im-

ages that show the correct dimen-

sions for that image type.   

These images can be updated either 

with the JustEdit  icon or the Im-

ages gadget as shown earlier. When 

using the JustEdit  icon, delete 

the default thumbnail image first. If 

the default image is not deleted pri-

or to navigating to the replacement 

image, the error message “You do 

not have the proper per missions to 

access this directory” will appear. 

If the Snippets gadget is not visible even after 

refreshing the page, click the  icon in the 

Gadgets sidebar and make sure that the check-

box for that type of gadget is selected.  

     
very 

important!

Quick
Tip!

1

2
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Content snippets
 

Content snippets are inserted in the main editable region of 

a page except for the links for multi-link list snippet, which is 

inserted in the last column of a multi-link list snippet. 

• The simple list snippet creates a list of items that may 

or may not link to other content.  Only one hyperlink 

per list item is allowed. 

• The multi-link list highlights content that may have mul-

tiple links per item (links within or outside the site or to a 

downloadable document).  Do NOT use with a callout. 

• The links for multilink list snippet is inserted in the 

last column of a multilink list snippet to easily create 

the three types of links.  

• The image grid snippet is used to create the image 

grid template. Do NOT use with any other snippet or 

banner image. 

• The expand and collapse widget snippet allows the 

user to drill into the details of multiple categories with 

ease. For example, it can be used to create pages for 

Frequently Asked Questions.  

• The responsive table snippet creates a mobile-friend-

ly table. Do NOT use with a callout. 

• The data table snippet creates an interactive table 

that allows sorting by column and searching the table 

content by keywords. Do NOT use with a callout. 
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Simple List
The simple list snippet can be used in the main editable 

region on any page type other than a grid page.  When 

inserted on the page, the simple list snippet will create a 

table with two default rows and four columns.  When past-

ing text inside the snippet table that was NOT copied from 

an editable region in OU Campus, make sure the  icon 

is clicked first to prevent unwanted formatting and styles 

from being introduced and possibly breaking the page.  

• (optional) The thumbnail images for the simple list 

snippet are optional but their use should be kept 

consistent - they should either be used on all list items 

or on none of them.  All thumbnail images should be 

uploaded in advance to OU Campus and should have 

the correct dimensions – 124 by 124 px.   

• Both “Title” and “Description” should be provided for 

each list item.  

• (optional) The “link” placeholder should be updated 

by using the  tool to navigate to a page in the 

same section. The text of the link will not display.  

• Additional list items can be inserted with the 'Insert 

Row Before' or 'Insert Row After' options from the 

JustEdit  dropdown.   Use the links for multilink 

list snippet below to create the links for the new table 

row. 

 

Simple lists only allow one paragraph of text 

and one link. Any styling or inline links within 

the description will automatically be stripped 

out and run together as one paragraph. 

     
very 

important!

When the page is published the snippet will  
appear like the one shown below. 

Choose the thumbnail image as a detail of 

the banner image on the page it is linking to.
best

practice
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Multi-link List
The multi-link list will appear as a table with two default 

rows and four columns.  When pasting text inside the snip-

pet table that was NOT copied from an editable region 

in OU Campus, make sure the  icon is clicked first to 

prevent unwanted formatting and styles from being intro-

duced and possibly breaking the page. 

The multilink list snippet is updated in the same manner 

as the simple list snippet. The only difference is in how its 

links are updated and displayed. 

• The multilink list supports several links per list item. 

• There are three types of links – link to an internal page 

(“Read More”), link to an external page (“External”), and link 

to a document (“Download”) – that are styled differently. 

• The text for the links can be modified but should be 

kept consistent across the site. 

• Additional list items can be inserted with the 'Insert Row 

Before' or 'Insert Row After' options from the JustEdit 

 dropdown.   Use the links for multilink list snippet 

below to create the links for the new table row. 

Links for Multilink List Snippet
The links for multilink list snippet is used to create the 

three types of links for a multilink list.  

When the page is published the snippet will  
appear like the one shown below. 

Quick
Tip!

Before inserting the links for multilink list 
snippet, delete the default bullet in the last 
column of the new row. If the link style does 
not render properly, place the cursor inside 
the link and select the  icon. Make sure 
the correct link class is selected from the 
'Class' dropdown (1).

1
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Image Grid Snippet
An image grid item snippet can be used to link to pages 

within the section, open an image gallery in a fancy box, 

or play a video in a light box. 

The image grid item snippet uses the familiar table layout. 

• Each row of the snippet creates an image grid item 

and should include an image (255 by 255 px), title, and 

description. 

• To link to a page from the image grid item, update the 

“Link” placeholder in the "Link or Asset" column via 

the JustEdit  tool.   

• To open an image gallery from the grid item, insert the 

image gallery asset in "Link or Asset" column. 

• To play a video, update the "Link" placeholder via the 

JustEdit  tool in the "Video Link" column. 

  

 

When the page is published the snippet will  
appear like the one shown below. 

Link Grid 
Item

Image Gallery 
Grid Item

Video Grid 
Item

Choose the grid image as a detail of the 

banner image on the page it is linking to. 
best

practice
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Expand-Collapse Widget 
The expand-collapse widget is a table with two columns: 

"Title" and "Expanded Details".  "Title" is the summa-

ry shown when the widget is collapsed and "expanded 

details" is the detailed description appearing when it is 

expanded.  The details section allows multiple paragraphs, 

inline links, bullets and other inline styling. 

     
very 

important!

The Expand-Collapse widget can support 

inline styling and links in the details but 

NOT in the summary. Do not create any 

hyperlinks in the "Title" column of the 

snippet.

When the page is published the snippet will  
appear like the one shown below. 
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Responsive Table
The responsive table snippet is preconfigured with 4 col-

umns and 11 rows. Rows and columns can be inserted or 

deleted via the "Row" and "Column" options of the JustE-

dit  dropdown.

Data Table
A data table looks like a regular table when updated with 

the JustEdit toolbar.  Additional rows and columns can 

be inserted  from the "Row" and "Column" options of the 

JustEdit  dropdown.   The keywords column will not 

display when the page is published but is used to store 

keywords for each row.  When a search in the data table is 

performed, only rows tagged with these keywords will be 

shown.  Each column of a data table will be sorted when 

its header row is clicked. 

 
When the page is published the data table snippet will  

appear like the one shown below. 

Data Table Snippet
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very 

important!
When changing the color, it is important to clear 

the current color first by selecting it again in the 

“Styles” menu before choosing a different color. 

Callout snippets
 

Before callout snippets can be inserted, the callout edit-

able region has to be enabled by selecting “Show callout 

column” and “Use local callouts” in page properties.  The 

callout editable region will appear in the right section of 
the page (1) when the page is viewed in edit mode. 

To create a callout snippet, choose the “Callout” catego-

ry when inserting it.  Select one of the eleven available 

callout options: simple callout, spotlight, quick-fact, audio, 

video, image gallery, single image gallery, flip card, calen-

dar, twitter, or form.  

The color for a callout is selected by placing the cursor 

in the “Color Sample” cell (2) of the snippet table (only 

image gallery callouts do not allow selecting a color) and 

choosing a color from the “Styles” JustEdit menu (3). 
         

 

 

3

2

1
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Simple Callout
The simple callout contains text with a color bar header 

and can be a collection of links, brief text or other related 

information.  If there is more than one paragraph or a list 

of links, it defaults to a gray color bar and garnet headline.  

The callout headline is required.

 

                  

 
       

 

Headline

Body Text

A sample simple 
callout
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Spotlight Callout
The spotlight callout is intended to visually highlight 

something or someone.  It features a prominent image, a 

short blurb of text and a single link if needed.  

• The spotlight callout can have one headline or two.  

The “Category” headline is optional.  

• The image is inserted in the "Photo" cell and should be 

465 pixel-wide.  

• The text typed in the 'Caption" cell will appear below 

the image.   

• The link is optional and will appear below the caption. 

 

Category
Headline

Image

Caption

Optional link

A sample spotlight 
callout

Avoid using headshots as callout images
best

practice
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Quick Fact Callout
The quick fact callout is designed to highlight one or more 

important facts about a school or program.  

• Both a number and description should be provided for 

each fact.  

• The snippet is preconfigured with three rows. With the 

cursor inside the Quick Facts section (1), select 'Insert 

Row Before' or 'Insert Row After' from the 'Row' op-

tion of the JustEdit  dropdown. 

A sample quick fact 
callout

1

Category
Headline

Number

Description
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Audio Callout
The audio callout features a short playlist and can be used 

to give a preview of performances or lectures.  

• Both “Title” and “Artist” should we provided for each 

recording in the playlist.  

• Audio callouts require a third party host like Kaltura. 

• Only the MP3 link should be updated with the audio 

link generated by Kaltura. 

Category

Playlist

A sample audio 
callout
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Video Callout
This callout includes an embedded video that, when 

clicked, will pop up in a light box and play from its source 

(e.g. Kaltura, YouTube).  It contains a still image with a play 

button to indicate the video.

• “Category” and “Caption” are optional.  The caption 

text will appear underneath the video.  

• The video callout image should be 465 by 310 px.  

• Paste the link generated with YouTube or Kaltura in 

the “Embed URL” table cell (1).  To generate the link 

from YouTube follow these steps:

 ◦ Navigate to the YouTube video.  

 ◦ Click on the link below the video. 

 ◦ Click on the button from the addition-

al menu that will appear. 

 ◦ Copy the entire string between the quotation 

marks (do NOT copy the quotation marks) after 

“src=”(2) that will appear inside a textbox.   
A sample video 
callout

1

Category
Headline

Video Thumbnail

Caption

2
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Image Gallery Callout
An image gallery callout showcases multiple images for 

users to browse through.  The callout will display up to 8 

thumbnails but the gallery can contain unlimited number 

of images.  When clicked, each thumbnail in the callout 

will open a light box where the viewer can click through all 

the images.

Image gallery callouts require that an image gallery asset 

be created beforehand.   

• Create an image gallery asset via the Asset Manager. 

• Select ‘Crop’ for ‘Thumbnail Aspect Ratio’ and type 

‘100’ in both the ‘W’ and ‘H’ text boxes for ‘Maximum 

Thumbnail Size’. 

• Insert the image gallery asset in the “Gallery Asset” 
row (1).  

• Provide a description in the snippet (2) that will 

appear above the image gallery thumbnails in the 

callout. 

     

A sample 
image gallery callout

Category
Headline

Gallery Asset

Description

A sample 
image gallery callout

Category
Headline

Gallery Asset

Description

2

1
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Single Image Gallery Callout
The single image gallery callout will display one thumbnail 

but the gallery can contain unlimited number of images 

that can be viewed when the thumbnail is clicked.  

Image gallery callouts require that an image gallery asset 

be created beforehand.  

•  Create an image gallery asset via the Asset Manager.  

•  Select ‘Crop’ for ‘Thumbnail Aspect Ratio’ and type 

‘465’ in both the ‘W’ and ‘H’ text boxes for ‘Maximum 

Thumbnail Size’.  

•  Insert the image gallery asset in the “Gallery Asset” 
row (1).  

•  Provide a description in the snippet (2) that will ap-

pear below the thumbnail in the callout. 

     

A sample 
single image gallery 
callout

Category

Headline

Gallery Asset

Description

2

1
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Form Callout
A form callout is designed to collect a small amount of 

information, such as an email address for a newsletter or a 

phone number for a follow-up call.  Only one form can be 

used on a page.  Form callouts require that a form asset 

be created beforehand.   

• Create a managed form asset via the Asset Manager.  

• Insert the form asset in the “Managed Form Asset” 
cell (1).  

• Provide a description in the snippet (2) that will ap-

pear above the form in the callout. 

     

Category
Headline

Description

Form AssetA sample form 
callout

2

1
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Twitter Callout
The twitter callout pulls tweets of a designated twitter 

account. The suggested category field is labeled “Latest 

Tweets” and the secondary headline identifies the twitter 

handle of the linked account.  

1. Type the Twitter handle/user name 

2. Type the Twitter Timeline Link from your profile in 

Twitter.

     

A sample twitter 
callout

Category

Twitter Handle
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Calendar Callout
A calendar callout displays up to five upcoming events 

from the UofSC calendar at http://www.sc.edu/calendar/
uofsc Each item holds the title, date, location, time, cost 

and a link to more details.To create a calendar callout:

1. Generate the link for the XML feed of events.  

2. Insert the calendar callout on the page  

 ◦ Select the “Calendar Feed” text and click the 

JustEdit tool.  

 ◦ Paste the XML link in the “Link URL” field of the 

“Insert/Edit Link” window(1). 

 ◦ Update “Title"(2) and “Link to Calendar”(3) if 
needed. 

 ◦ Type a number to select how many events to 

show up in the callout (up to 5). 

     

A sample calendar  
callout

Title

Calendar Feed

Link to calendar

2

3

1
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Contact Callout
The contact callout displays contact information (name, ti-

tle, phone number, email address, and a link to their profile 

page) for up to three people from the faculty and staff di-

rectory and displaying their contact information.  It allows 

maintaining the information in one place — on the profile 

pages — and will automatically update should the profile 

information change.  It is styled like a simple callout.   

1. Fill out a headline and a caption.   

2. Link to the “index.pcf” page in the faculty and staff 

section.  You can link to a directory outside of the cur-

rent site, but everyone in the callout must be from the 

same directory. For example, you can use this callout 

on your internal site to display directory information 

from your external site.  

3. Link to each profile page (up to three) – e.g. high-

light the word “Profile 1” and use  to navigate to 

the respective profile page.  The “Profile 1” text can 

be updated with the actual name of the faculty/staff 

member. 

4. The callout will default to gray if a color is not selected 

from the “Styles” menu.

     

A sample contact callout

Headline

Profile 3

Profile 2

Profile 1

Caption
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Assets allow sharing content across pages or sites in OU Campus. When 

an asset is updated and published, all pages utilizing the asset will also be 

updated and published by the OU Campus CMS. 

There are also specialized assets, managed form asset and image gallery 

asset, that allow creating online forms and image galleries. 

Section Six
Assets Section Contents

Creating an Asset - All Asset Types  ........................................64
Form Asset  ........................................................................................... 65
      Elements  ........................................................................................ 65
      Form Field Attributes  ............................................................. 66
      Email Messages  ...........................................................................67
      Form Settings   .............................................................................67
Image Gallery Assets ...................................................................... 68
Web Content Asset  ......................................................................... 69
      Asset Content  ............................................................................. 69
Plain Text Asset  ................................................................................. 70
      Asset Content  ............................................................................. 70
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Assets
 

Assets are global elements that allow sharing of reusable 

content across one or more sites in OU campus.  They 

should be used when multiple pages require the same 

information to be displayed in the same way.  Assets allow 

updating content in one place.  There is also specialized 

content that can only be created as an asset such as im-

age galleries and forms.  Assets are applied to pages via 

the JustEdit  icon.  

There are 4 types of assets that a user can create:

• Web Content - used to create callouts, snippets, 

styled text, images or videos shared across pages.  

• Plain text - used for plain text only, ideal for simple 

information such as enrollment numbers, phone num-

bers, etc.  

• Image Gallery - used to create a collection of imag-

es with captions, added to image gallery callouts or 

image grid items. 

• Managed Form - used to create forms to add to a 

page or callout, whose submissions can be both 

emailed and saved in a database.
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Creating an Asset –  
All Asset Types
 The setup wizard will change based on the type of asset 

but there are common fields for all assets.  To create an 

asset:

1. Access the asset manager by clicking on the “Con-

tent” tab and selecting the “Assets” option. 

2. Click the “New” button  . 

3. Choose one of the four available asset types from the 

list: Web Content, Plain Text, Image Gallery, or Man-

aged Form. 

4. Provide descriptive “Asset Name” that will appear in 

the asset manager.  

5. (optional) Provide a “Description” of the asset.  The 

asset description is not displayed anywhere except 

inside OU Campus for reference. 

6. Make sure the “Lock to site”(1) checkbox is selected 

to make the asset invisible to other sites in OU Cam-

pus.  Image gallery and form assets are limited to the 

site where they are created.    

After assets are created and published, they can be insert-

ed into pages via the  icon (2) to become part of their 

content.  

     
very 

important!

     
very 

important!

The asset manager does not support grouping assets within 

a folder structure and it is important that asset names follow 

some conventional method.  For example start all gallery 

assets with "gallery_ " in the beginning of the name, or all 

callouts with "callout_".

Be sure to lock assets 

to the site.  Other-

wise, users who may 

not have access to 

this site, will still be 

able to see, edit, and 

use the asset as it will 

appear on all sites in 

OU Campus. 

3

1

3

2
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Form Asset
In addition to the common fields in the asset manager de-

scribed above, there are additional sections of Elements, 

Email Messages and Form Settings for the form asset.

Elements
This section allows adding form fields. 

• single-line text field– for shorter text

• multi-line text field – for longer text

• radio buttons – for selecting no more than one of sev-

eral available options

• check boxes – for selecting one or more of several 

available options

• Date/Time Picker

• drop-down menu – for selecting one option

• multi-select menu – for selecting more than one op-

tion by holding down the “Ctrl/Control” key

To add an element, click on the type of element in the 

“Form Elements” toolbar, the ‘+’ sign (1), or simply drag 

the element inside the “Elements” area.  Fill out the form 

field attributes described below to create the element.

To change the order of elements, select the element and 

drag and drop it in the desired order.  To remove an ele-

ment, click the black 'X' sign (2) in the top right corner of 

the element. 

                  

 

1

2
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Form Field Attributes 

“Name” – automatically generated from the “Label” at-

tribute when the form field is created.  It is used to create 

the database record.  The form data will break if any two 

elements have an identical name.  

“Label” – used to generate the “Name” attribute and pro-

vide a label for the form element.   

“Required” (2, R) – prevents submission of the form if this 

field is left empty.  It is only available for single-line and 

multi-line text fields.  

“Default” (3, D) - displays as a prompt but will not be re-

corded in the database.   

“Validation” (4) - allows three options for field validation:

• “Email” - validates that the entered text contains the “@” 

symbol.   

• “Minimum Length” - validates that the number of charac-

ters entered will be at least the minimum length.  

• “Regex”- allows entering a regular expression (regex) to 

validate against the form input. 

“Failure Text” (5, FT) – appears whenever an element is 

marked as required or a validation for an element is selected 

but the data input is missing or invalid. 

2

3

4

5

FM

R

A

D

FTUse the Instructional text field to add headings 

and paragraphs between form fields as needed.
Note
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Email Messages
In addition to saving each form submission in a database, 

email messages can be sent to one or more recipients 

when the form is submitted successfully.  Fill in the infor-

mation for the email message.  All fields (“To”, “From”, 

“Subject”, and “Body”) must be filled out or the form 

asset cannot be saved.  Data from the submitted form 

can be automatically populated into the email.  To include 

the dynamic data, the “Name” attribute for the respective 

element must be enclosed in curly brackets as shown in 

the example (1).  

Multiple personnel may require the data collected in a 

form.  Emails can be sent to each of these individuals.  

Include all emails in the “To” field separating them with a 

semicolon followed by space or set up a separate email 

message for each user. 

Form Settings
This area is for setting up success and failure messages 

when the form is submitted.  

 

Success Message – appears on the same page when the 

“Submit” button is clicked and the form submission is suc-

cessful.  Its text can be fully customized by the user.  

Failure Message - appears on the same page when the 

“Submit” button is clicked and required fields are missing 

or of the wrong format.  

1
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Image Gallery Assets
In addition to the common fields in the asset manager, 

there is an additional section called “Gallery Options”.

1. Click the “Create” button to begin adding images.  The 

“Images” section will appear.   

2. Navigate to the gallery images on the local computer.  

Images should be sized correctly before being upload-

ed to the image gallery – dimensions should be 1024 

by 683 px or 683 x 1024 px.  Hold down the ‘Ctrl’ or 

‘CMD’ key to select multiple images.   

3. Drag and drop the images inside the icon for the ac-

tive browser in the task bar and then inside the “Imag-

es” section of the asset.  Alternatively click the “Add” 

button inside the “Images” section to add the images 

without dragging and dropping.  

4. Provide a description for each image in the “Caption” 

field.  The rest of the fields are not currently used. 

5. Choose “Crop” (1) for the “Thumbnail Aspect Ratio”.  

This will ensure all thumbnail images in the gallery are 

the same size. 

6. Click the ‘‘Set” (2) button opposite the “Maximum 

Thumbnail Size.” Leave dimensions as 100 by 100 px 

unless the asset will be used in a  single image gallery 

callout. In latter case, type 465 in the 'W' and H' text 

boxes. The thumbnail images will be generated by OU 

Campus.  

7. Click “Save”. 

 

     

1

2
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Web Content Asset 
In addition to the common fields in the new asset manag-

er, there is an additional section of Asset Content.

Asset Content
This Asset WYSIWYG editor has a   icon allowing 

inserting snippets like simple lists, callouts, and other for-

matted content.  The styling of some of the snippets might 

be a little different and won't render the proper display 

until the asset is inserted on a page, but the snippets will 

function correctly. 

Web content assets are ideal where the same content, 

styled in the same way, will be used on multiple pages.  

For example, if contact information for a faculty member 

needs to be displayed inside a simple callout on multiple 

pages, rather than creating the same callout on every 

page, create a web content asset and insert the simple 

callout on it with the Asset WYSIWYG editor  icon.  

Publish the asset and insert it inside the callout editable 

region of each page where it needs to appear – do NOT 

insert it inside a simple callout.  If any of the contact infor-

mation changes, only one asset needs to be updated and 

republished.  All pages using the asset will be republished 

by the OU Campus system. 

       

     

The color of the snippet cannot be 

changed via the Asset WYSIWYG editor.
Note
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Plain Text Asset 
In addition to the common fields in the new asset wizard, 

there are is an additional section of Asset Content.

Asset Content
This section allows typing content without any styling ap-

plied to it.  When placed on a page in a line of text, it will 

take on its text styles.  Plain text assets are ideal for statis-

tical information such as number of students registered (1)

or number of programs offered.  As such, they can also be 

inserted inside quick fact callouts. 

 

     

11,300
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Before publishing, pages can be previewed within OU Campus on the 

staging, test, or production server. They should be published to the test 

server and reviewed before being made live on the production server. 

Section Seven
Preview and Publishing Section Contents

Preview  ...................................................................................................72
Publishing  ..............................................................................................73
      Publishing to the Test Server  ...............................................74
      Publishing to the Production Server  ...............................74
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Preview and Publishing
Preview
 

A page can be previewed in OU Campus before being 

published to the web site.  To preview a page, choose the 

“Preview” option from the “Review” menu in the Con-
tent Pages view (1) or click on the 'Preview' tab (2).  The 

preview would default to the production server, the local 

server hosting the live web site.  A different server can be 

selected from the server menu (3).  The staging server is 

the remote server where pages are edited in OU Campus. 

The test server is a local server used to review content 

while it is being developed.   Multi-browser preview (4) 
allows previewing the page in a variety of browsers across 

multiple platforms.  

 

   

2
3

1

4
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Publishing
 

Pages in OU Campus are not public.  Only after they are 

published, can they be viewed by an audience.

Pages are published by either the  menu in the 

Pages List view or by clicking the   button 

that will appear when a page is accessed via the “Edit” or 

“Review” menu. It is important that a version description 

be provided to easily identify the page version if reverting 

to it in the future.  

Every time a page is published, it is saved in the OU Cam-

pus version system and can be reverted to later. A version 

of a page can also be saved without publishing by choos-

ing 'Save Version' (1) from the 'Review' menu.

 

 

         

1

Quick
Tip!

To revert a page, choose 'Versions' (2) from the 

'Review' menu. Identify the page version, hover over 

it and select 'Revert' (3). Publish the page to the test 

and production server.

2

3
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Publishing to the Test Server
The test server is an exact replica of the production server 

and can be used to preview site content while it is being 

developed.  The HTTP root for the test server is http://ar-

gon.qa.sc.edu – to preview a site on the test server replace 

the http://www.sc.edu portion of its URL with it. 

All pages, images, and documents should be published to 

the test server during development.  Only after content 

has been finalized, should pages be published to the pro-

duction server. 

To publish a page to the test server, select “Test” (1) from 

the “Publish Target” menu.  Providing a version descrip-
tion (2) is strongly recommended.  Make sure all images 

and documents utilized by the page are published to the 

test server as well.  Since redirects do not work on the test 

server, links to www.sc.edu pages not maintained in OU 

Campus will appear broken on the test server.  They will 

work fine on the production server.  

Publishing to the Production Server
Once the content for a page has been finalized, the page 

can be published to the production server.  Choose “Pro-
duction” from the “Publish Target” menu and provide a 

version description.  Don’t forget to publish any associat-

ed images and documents.  

2

1

     
very 

important!

Publish each page to the test server first, check it in a 

browser, not just in OU Campus, and once all changes 

appear fine, publish it to the production server. Be 

sure to check on mobile devices as well or use the 

multi-browser views and resize your browser to a 

mobile width.
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